
United States Department of the Interior 
NATIONAL PARK SERVICE 

MID-ATLANTIC REGION 
143 SOUTH THIRD STREET 

IN REPLY REFER TO: PHILADELPHIA, PA. 19106 

N16(MAR-MR) 

Memorandum 

To: Superintendents, MAR 

From: Regional Director, MAR 

Subject: Revision of Resource Management Plans 

The most recent version of the National Park Service's Resource 
Management Plan (RMP) software and the file copy of the User's 
Manual is being sent to you via SEAdog. A laser jet printed hard 
copy of the User's Manual is also being sent through the mail. The 
Manual needs to be printed on a laser jet printer to retain all of 
its graphic headlines. 

This revised version allows for the incorporation of data entered 
using the older version of the software. The new program, when 
properly installed, will automatically "unpack" itself and copy all 
of the necessary files into the RMP subdirectory. The program 
won't overwrite or erase existing data, but will convert it into 
the new program. All parks should use the new software to write 
new project statements, update their RMP's and to submit the RMP 
update reports of the required tables and programming sheets. 

In September 1990 a memorandum from the Regional Director 
established deadlines for each park to submit their next Resource 
Management Plan revision. We expect those plans to be submitted by 
their scheduled due dates, using the new software. This process 
should be completed for all the parks by September 30, 1992. David 
Reynolds, who has recently filled the position as Natural Resource 
Specialist vacated by Kathy Jope, will be contacting each park soon 
concerning the status of their RMP's. 

Before you install the software on your computers, read the User's 
Manual instructions carefully. Pay particular attention to the 
fact that some DOS versions, prior to version 3.3, contain known 
bugs and will cause problems when you install this software. 
Therefore, if your current computer has a DOS version lower than 
3.3, you should upgrade to DOS versions 3.3, 4.01 or 5.0, 
regardless of which software you now use. 

We want to encourage those units which have not yet submitted an 
updated Resource Management Plan to make it one of their top 



priorities. These plans are critical at the park, Regional and 
Washington levels for information compilation and to obtain 
research and resource management funding. 

Questions should be directed to David Reynolds at FTS/215 597-5372. 

Enclosure 

2 

\Lorraine Mintzmyer 

file:///Lorraine


NATIONAL PARK SERVICE 

RESOURCE MANAGEMENT PLAN 

RMP 
SOFTWARE MANUAL 

1991 

Prepared by 
Walter Sydoriak 

Computer Specialist, SWRO 



Contents 

1. Overview and Installation 1 
Technical Support 1 
Installing the RMP Software 2 

2. How to Get Around in the Program 5 
A Brief Word about Menus 6 
How to View the Project List Screen 7 
How to Add a New Project Statement 8 
How to Append Existing Projects from a Separate Database 8 
How to Enter Data into the Project Statement 10 
Moving Text to and from WordPerfect 12 
How to Edit/Change an Existing Project Statement 13 
How to View the Funding Screen 14 
How to Delete a Project Statement 14 
How to Print Project Statements, Programming Sheets, and Tables . . . 15 
How to View the Personnel Table List Screen 16 
How to Add a New Personnel Table 17 
How to Append Existing Personnel from a Separate Database 18 
How to Edit/Change an Existing Personnel Table 18 
How to Delete One or All Personnel Tables 19 
How to Print Personnel Table 2 19 
How to Quit to DOS 19 

3. Menus and How to Use Them 21 
The File Menu 23 
The Edit Menu 24 
The Locate Menu 25 
The Print Menu 27 
The Setup Menu 28 

4. Required and Optional Equipment 31 
Equipment Requirements 31 
Optional Equipment 32 

Appendix A 
Project Statement Sheet 35 

Appendix B 
Servicewide Issue Codes 37 

Appendix C 
Cultural Resource Type Codes 39 

RMP Software Manual 111 

c 



Appendix D 
Compliance Codes 41 

Appendix E 
Categorical Exclusions 43 

Appendix F 
Funding Source Codes 53 

Appendix G 
Activity Codes 55 

IV RMP Software Manual 



1. Overview and Installation 1 
These directions have been written for the Resource Management Plan 
(RMP) software. The intent is to make them as simple as possible so that 
someone new to computers can enter data as easily as someone with experience. 

The RMP software enables you to enter your Resource Management Plan project 
statements in a consistent, easy to edit format. With this program, you can also 
generate programming sheets and tables required by the plan. 

In this manual, a word typed in brackets U signifies a single button to press. For 
example, [Enterl means to press the button marked "Enter", IY] means to press 
the letter "Y", and [PgDn] means to press the page down button. 

The [Ctrl] and [Alt] keys are pressed in conjunction with other keys to perform a 
function. When pressed alone, they do not perform any action. The [Escl 
(abbreviation for Escape) key is used to "back out" or "escape" from a menu, 
command, or data entry screen. 

A frequent mistake for some users is to hold a key down for too long. Computer 
keyboards send the pressed key continuously while the key is held down. 
Therefore, the word "press" indicates a quick short keystroke and "press and 
hold" will be used to indicate just what it says. 

As new features are added and old problems are corrected, the RMP software is 
upgraded. If the changes are few, this manual might not be reprinted; a file 
called README may be sent with the upgrade which contains new information. 
When the changes are large, a new manual will be sent with the program 
upgrade. 

Technical Support 

If you have any questions, comments, or suggestions, send them to the author: 

Walter Sydoriak (505) 988-6438 
P.O. Box 728 fts 476-6438 
Santa Fe, NM 87504 

Before you call, please make clear notes of exactly what has occurred. If 
possible, print the message displayed on your screen, if any, for reference during 
the call. 
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Installing the RMP Software 

The following instructions take you step-by-step through installing the RMP 
program on your computer. Before proceeding, make sure you know the location 
of the A, B, and C dnves on your computer, and that you have a floppy disk with 
the RMP program on it. This new version will convert older versions of the 
RMP program (beginning with version 1.5) automatically. 

1. Turn your computer on. 

2. If you already have an RMP directory, skip this step. 

Type md \rmp [Enter] to make an RMP subdirectory. 

3. Type cd \rmp [Enter] to "log" into that subdirectory. 

4. Insert the disk labeled RMP PROGRAM DISK into either drive A or B. 

Type a:install [Enter] or b:install [Enter] (depending on the drive you are 
using) to install the software. This will extract the new RMP software from 
the distribution disk and install it into the directory that you are logged into 
on the hard drive. 

5. Type dir [Enter] when you are returned to the blinking DOS prompt to 
view the directory. There should be seven files listed. 

RMP.EXE main program 
RMP.OVL sub programs 
RMP COMP.DBF compliance codes 
RMP~TYPE.DBF cultural resource types 
RMPJSSU.DBF issue codes 
RMP SOUR.DBF funding source codes 
DATATJICT.DBF used to create any missing database files 

NOTE: The installation does no! overwrite any existing data files (the project 
statements you may have entered on a previous version of RMP). Old data is 
automatically converted. To be on the safe side, the RMP program will make a 
copy of your old data and save it in a directory named "OLDDATA". If you 
don't have any data from a previous version of RMP, the program will create an 
empty database upon startup. 

6. Type RMP [Enter] to run the program. 

Refer to other sections of this manual for specific functions of the RMP 
software. 

7. During program initialization, the program checks to sec if your 
CONFIG.SYS file is set properly. If not, you will be notified (see Figure 1). 
The program will correct the file if you wish. These changes should make 
you computer behave better with other software as well. A backup of the 
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CONFIG.SYS file, named CONFIG.RMP, will be made in the C:\ directory 
should you decide you want to change back. 

NOTE: Some DOS versions prior to version 3.3 may not work properly with 
the RMP software. These DOS versions contain known bugs, and are limited 
in several important ways. You should upgrade you DOS version to 3.3, 
4.01, or 5.0 regardless of which software you use. 

The RMP program checks the system date of your computer. It must be 
greater than the date of the RMP program file. Since many file operations 
are dependent on an accurate date and time, the program will not run unless 
you set them correctly. If you find that your computer doesn't "remember" 
the date and time that you set from day to day, then you probably have a bad 
or worn out clock battery. You can either replace the batteries, or buy a 
small clock card. Consult with technical support, or your park ADM officer. 

Old versions of RMP data will be converted automatically. However, 
previous versions that were manually entered in DBASE are often full of 
errors. Invalid codes, multiple data records for one project, and a wide range 
of formats for project numbers-cause a wide range of headaches during 
conversion. Therefore, after any database is converted or appended, a menu 
of errors will appear, allowing you to view any invalid or confusing entries. 
You should check project numbers, titles, and codes very carefully after any 
conversion is done. 

Figure 1. CONFIG.SYS file not set correctly. 

RMP Software Manual 3 



a 2. How to Get Around in the Program 

After you start the program, the welcome screen will appear (see 
Figure 2). You may want to use the tutorial in this program. The tutorial will 
familiarize you with the RMP software menus. You can quit it any time by 
pressing lEscl repeatedly. While you are in the tutorial, you can't really CJQ any 
program operations. With the tutorial, you can move from command to command 
to see what is available, and get familiar with how menus work. 

The RMP software contains five major screens: 

1. Project statement list (Figure 3, page 7) 
2. Project statement data entry (Figure 4, page 8) 
3. Project statement funding data entry (Figure 6, page 14) 
4. Personnel tables list (Figure 8, page 16) 
5. Personnel tables data entry (Figure 9, page 17) 

Moving between screens is detailed in these instructions. The project statement 
functions are very similar to the personnel table functions. Menu selections 
operate very much the same from screen to screen. 

Figure 2. Welcome screen, tutorial option. 
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A Brief Word about Menus 

The RMP software menu system is based on a standard method used by most 
major software today. The list of menu commands at the top of the screen is 
called the menu bar. In the opening menu bar, there are six options for you to 
use: File, Edit, Locate, Print, Setup, and Help. To access these menu options, 
press [Altl and the first letter of each word. For example, to edit a project 
statement, press [Alt El for the Edit menu. A submenu drops down below the top 
line with other menu commands such as Modify, delete, Add, and Append. 
Select a command by pressing the highlighted letter, or by using the arrows to 
highlight the command and pressing [Enter]. If a menu command is not available 
at a particular point in the program, it will appear gray (on color screens) and 
will have the prefix 'N/A'. Any menu can be aborted by pressing [Esc]. 

Some frequently used menu commands can be selected immediately without going 
through the menu system. These are called "shortcut keys". They can be found 
listed after some menu commands- For example, under the "Edit menu 
selection, there are several shortcut keys~[Alt Ml for Modify, [Alt D] for Celete, 
[Alt A] for Add-which can be pressed at any time. If you were viewing a project 
list screen, you could press [Alt M] to Modify the current highlighted entry 
rather than first pressing [Alt E] for the Edit menu and then [M] to Modify. 
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How to View the Project List Screen 

After you finish the tutor, or if you bypass it, you will see the project list screen 
(see Figure 3). If you had data that was converted from a previous year, you will 
see those project statements. If you don't have any data yet, you will see a 
message stating that the database is empty. 

The top right comer of the screen shows what item number (database row) you 
are on, the physical record number, and how many total records exist in the 
database. The project numbers are sorted alphabetically, so the item numbers are 
consecutive, but the record numbers might not be. Shortcut keys are listed at the 
bottom of the screen. You can select a project number by moving the cursor to 
highlight the project number or by pressing the first letter of the project statement 
if you have more than one park's data. For example, if you want to see the 
project numbers for BICY you would press [BJ and then scroll through the B's 
with the arrow keys until you get to the project number that you want to view. 
To view a project, press [Enter] or [Alt M] for Modify. 

You can switch between project statements and personnel tables with the shortcut 
keys [Alt J] for project statements and [Alt T] for personnel iables. 

Figure 3. Project statement list screen. The first project number is highlighted. 
Move highlight with arrow keys or press first letter of a project statement. Follow 
instructions at bottom of screen. 
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How to Add a New Project Statement 

To add a new project statement, start the RMP program and press [NJ at the 
tutorial prompt. You will then be on the project list screen (see Figure 3). Press 
[Alt E] for the Edit menu and [A] to Add a new project statement (or just the 
shortcut [Alt AJ for Add). A blank project statement data entry screen will 
appear (see Figure 4). Enter a project number first. Until you do, you won't be 
able to move to other fields. 

If you press [ESC1, a message will appear notifying you that the new project 
statement has not been saved and asking you if you want to save the data. If not, 
the new project statement is discarded. You must press [Alt XI to save and E^it 
this process (adding a new project) or [Escl to abort before you can add another 
new project. 

How to Append Existing Projects from a Separate Database 

You may have some project statements entered with an earlier version of the 
RMP software and that are now in another directory that you would like added or 
"appended" to your "new" RMP database, or you may have some project 
statements on a floppy disk that you want to merge into your database. This 
function works for both the project statements and personnel tables, depending on 
which one is currently displayed. This function avoids appending duplicates, and 
automatically converts data from previous versions of the RMP software. 

Figure 4. Project statement data entry screen. 
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To begin the append, press (Alt E] for the Edit menu and [P] for Append. A 
dialog box will appear into which you must type the full DOS path to the desired 
"source" database (see Figure 5). During the append, duplicate project numbers 
are rejected, invalid codes are noted, old versions of the data are converted, data 
may be merged from several source records into one current record, and new 
project numbers may be created. If any of these occur, you will have the option 
of viewing and printing the changes after the append is completed. You should 
check the data carefully after an append to correct invalid codes, and to see if all 
of the data was merged successfully. Some of the inconsistencies include: 

Invalid Codes - codes which were invalid during the conversion from 
previous year's data. 

Combined records - records that were combined into one record because 
duplicate project numbers existed. Some users have previously entered single 
projects into several separate data records in order to split funding amounts. 
If a project number and title is duplicated in the source file, the duplicate 
records will be combined. 

New project numbers - created by the program during the append because 
you did not want to combine multiple duplicate source project numbers into 
one. 

Older versions of the RMP databases use two 25 character long fields for the 
title. Newer versions combine that into a 50 character field. Some previous 
project titles contained words that were broken between the two fields, and during 
combination, a space will now break the two words. Check project tides 
carefully. 

Figure 5. The append dialog box. 
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How to Enter Data into the Project Statement 

Start the RMP program and press [N] at the tutorial prompt. You will be on the 
project list screen (see Figure 3). In the middle of the screen you will see the 
current list of existing project statements. Open a project statement data entry 
screen by doing one or the following: 

1. Add a new, blank project, by pressing [Alt E] for the Edit menu and [A] 
to Add a new project (or just the shortcut [Alt Al). A blank data entry 
screen will appear on the screen (see Figure 4). 

OR 

2. Change an existing project by using the up and down arrows to move to 
the project statement you wish to edit or pressing the first letter of the 
project number you wish to see and scrolling to the exact one. Then 
press [Alt E] for the Edit menu and [M] for Modify (or just the shortcuts 
[Alt M], or [Enter]) to view, edit, change, or modify that project 
statement. The project statement you've selected for editing will appear 
on the screen (see Figure 4). 

Begin typing into each field. On the top right of the screen is either the word 
"overwrite" or "insert", which shows you whether what you type will write over 
existing text, or insert into it. Change this by pressing the [Ins] key. When done 
with a field, press [Enter]. Move between fields with the arrow keys. As you 
move to each item or field in the project statement, the message line at the bottom 
of the screen will help you complete that field. 

For example, if the project number field is highlighted, the status line will read: 
"Enter the Project Number: PARK - N, C, I, or S - number.subproject number." 
This means that you should type BICYNO01.001 for the project number (the park 
is BICY, the project is in the Natural resources category, this is project number 
001, and this is subproject .001). If you make an invalid entry in a field, a help 
window will show the valid entries for the field. Keep an eye on the message 
line; some fields allow you to Eick from a list of choices by pressing [Ctrl P]. 

1) Project Number. Four letter Park Alpha Code followed by N-Natural, C-
Cultural, I-Interdisciplinary, or S-Subsistence followed by RMP project 
number followed by a subproject number if one is to be used, i.e. 
BICYNOOl.OOl. The hyphens in the display are to help in data entry, and 
are not made a part of the actual project number. 

2) Priority. Enter a number from 0 through 999 to show the park priority for 
the unfunded component of this project. If project is completely funded, 
enter a 0. 

3) Project Title. You can only enter a maximum of 50 characters for this field. 
Try to make this as meaningful as possible. 

3a) Subproject Title. This field only appears if you have entered a subproject 
number in the project number. 
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4) Servicewide Issue Codes. Enter one or two issue codes (press [Ctrl P] to 
Eick from standard list or see Appendix B). 

5) Cultural Resource Type. Enter cultural resource type: SITE, STRC, 
OBJC, ETHN, CULL, or COMB. (These appear on the message line at the 
bottom of the screen. See Appendix C.) 

6) Package Number. If the park has a current 10-238 request pertaining to this 
project, enter the specific identifying number from the corresponding 10-238. 
Do not just enter "238*. 

7) Compliance Code. Enter one or two compliance codes (press [Ctrl P] to 
Eick from standard list or see Appendix D). 

8) Explanation. Enter the explanation for the compliance code fMust be 
completed if compliance code is EXCL, DOC, and/or OTHER). 

9) Funding. Press [PgDn] to enter or edit funding information on the funding 
screen (see Figure 6, and also "How to View the Funding Screen" on page 
14 for more information). The funding screen allows you to enter all the 
information on both the funded and unfunded components of your project for 
up to four years and from up to four sources per year. The screen is divided 
in half, with the left half showing four years of funded data and the right half 
showing four year of unfunded data. For each year of funded (or unfunded) 
data, you can enter up to four "lines" of data, with a "line" corresponding to 
a combination of funding source, activity type, budget, and FTE. Thus, if 
your project is funded from two different sources, one to support the research 
aspect of the project, and the other to support the monitoring aspect, you 
would enter these two combinations on two different lines in each year for 
which they apply. 

If you want to use the same funding information (i.e. funding sources, 
activity type, budget, and FTE) over multiple years, you can easily copy 
all of the information from one year to another by pressing [Alt E] for 
the Edit menu and [C] for Copy funding and following the instructions. 
If the same funding data applies to several years, repeat this copy 
operation for each year. 

SOURCE -- Enter funding source code (press [Ctrl P] for a list of valid codes 
or see Appendix F). In FY91, the RMP program began using new 
funding source codes. If you happen to still be using the "old" codes, 
the program will tell you "That is an old code" and will show you the 
new codes for this funding source. You can either choose the new code 
the program has highlighted for you, or some other new code that you 
feel is more appropriate. 

ACT -- Enter activity code (RES (Research), MTT (Mitigation), MON 
(Monitoring), PRO (Protection), ADM (Administration), or INT 
(Interpretation) or see Appendix G). 
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BUDGET - Enter budget $ in thousands to nearest hundred (i.e. 9.9 for 
$9,900). 

FTE - Enter FTE amount to nearest .1 FTE (i.e. 999.9). 

Press [PgUp] or [Alt X] to save and Exit this process back to the project 
statement data entry screen. 

While in the funding screen, you can press [Ctrl PgUp] or [Ctrl PgDn] to flip 
between project statements. All data will be saved and the previous or next 
project statement will be displayed, allowing you to edit, print, etc. 

10) Problem Statement. Press [Ctrl Enter] or any letter to invoke the text 
editor. A blank box will appear into which you type your problem statement. 
Press [Alt X] to save and Exit this process, or [ESC] to abort the edit. 

11) Description of Action. Press [Ctrl Enter] or any letter to invoke the text 
editor. A blank box will appear into which you type your description of 
action. Press [Alt X] to save and Exit this process, or [ESC] to abort the 
edit. 

12) Alternative Action and Impacts. Press [Ctrl Enter] or any letter to invoke 
the text editor. A blank box will appear into which you type your alternative 
actions. Press [Alt X] to save and Exit this process, or [ESC] to abort the 
edit. 

NOTE: on these last 3 narrative fields, see "Moving Text to and from 
Wordperfect" on page 12 for more information on how to import/export 
Wordperfect text for these fields. 

You can flip between project statements by pressing [Ctrl PgUp] or [Ctrl PgDn] 
without having to return to the project list screen. All changes you may have 
made will be saved. 

Moving Text to and from WordPerfect 

The fields "Problem Statement", "Description of Action", and "Alternative 
Actions" are narrative text fields. They can hold up to about 60,000 characters 
(please don't enter that much!). To edit one of them, press [Ctrl Enter] while the 
cursor is on the field. A word processor screen will open into which you can 
type text or import text from an ascii or WordPerfect file. 

Start typing text. The words will automatically wrap at the right margin. A help 
box below the menu bar will help you insert and delete text. For example, to 
delete an entire line, press [Ctrl Y]. To delete a word, press [Ctrl T]. To 
reformat a paragraph after editing, press [Ctrl B]. When done, press [F7], just as 
you would m WordPerfect. 

To copy, move, or delete text, first mark the text by pressing [Alt F4] or [Alt B] 
for Block and [O] to turn the block On. Move the cursor. Then, if you press 
[Dell, the block will be deleted. Otherwise, press [Alt B] to select the copy or 
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move commands. These commands use what is called a "clipboard". This is a 
temporary storage area to which you can copy and from which you can retrieve 
data. Shortcut keys are listed after each command. 

Exporting Text 

You can use the File menu ([Alt F]) followed by [A] to save to file _ _ ^ to 
export the text in wordprocessor format or DOS text file format. Wordprocessor 
format means that all paragraphs are turned into one long line of text so that when 
you retrieve the file into WordPerfect, it can break the lines in the proper places 
with soft carriage returns. DOS format means that all lines in a paragraph are 
ended with a hard carriage return so that the file can be printed directly to a 
printer from DOS. A dialog box will appear into which you enter a file name to 
which you want to save the entire narrative field. 

Importing Text 

You can import text from a WordPerfect file directly into the word processor 
screen. Press [Alt F] for the Eile menu and then [I] to Import text. A dialog box 
will appear into which you type the complete directory and file name of the file 
you want to import, unless the file is in the current directory, in which case all 
you need to type is the file name. The document will be imported, but many of 
the formatting codes specific to WordPerfect will be removed. You will probably 
have to clean up your document some. You can continue editing the data in any 
way. When you are done, press [F7] to exit, as you would in WordPerfect. 

How to Edit/Change an Existing Project Statement 

To change or edit an existing project statement, start the RMP program and press 
[Nl at the tutorial prompt. You will be on the project list screen (see Figure 3). 
In the middle of the screen you will see the current list of existing project 
statements. Use the up and down arrows to move to the project statement you 
wish to edit or press the first letter of the project number you wish to see. Then 
press [Alt E] for the Edit menu and [M] for Modify (or just the shortcuts [Alt Ml, 
or [Enter]) to view, edit, change, or modify that project statement. The project 
statement you've selected for editing will appear on the screen (see Figure 4). 
Change whatever needs to be changed and press [Alt XJ to save and Ex.it this 
process (the project statement data entry). For example, if you wanted to change 
the funding amounts, you would press [PgDn) to edit the funding data, change 
whatever funding amounts you want, press [PgUp] or [Alt X] to save and Ex.it the 
funding screen, and then [Alt XI to save and Exit the project statement data entry 
screen. The message bar at the bottom of the screen gives help on how to 
complete funding sheet items. 

You can flip between project statements by pressing [Ctrl PgUp] or [Ctrl PgDn] 
without having to return to the project list screen. All changes you may have 
made will be saved. The previous or next project statement will be displayed and 
you can edit or print it. 
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How to View the Funding Screen 

The funding table is a part of the project statement. Therefore, you have to be 
editing a project statement in order to view the funding screen. Select a project 
statement to edit by: moving the highlight bar in the project list screen and 
pressing [Enter] (notice the budget summary in a box on the right of the project 
statement data entry screen (see Figure 4)). Then press [PgDn] to see the funding 
screen (see Figure 6) for budget dollar entry. Each year will allow up to four 
different combinations of funding source, activity, budget, and FTE. You can 
press [Ctrl P] to Pick a funding source from a list. Press [Pgllpl or [Alt X] to 
save and Exit this process (editing the funding table), or [ESC] to abort the edit. 
See the section "How to Enter Data into the Project Statement" on page 11 for 
more information. 

You can flip between different project statements by pressing [Ctrl PgUp] or 
[Ctrl PgDn]. All changes you may have made will be saved. The project 
number, title, subtitle, and priority will be listed on the message line at the 
bottom of the screen. 

How to Delete a Project Statement 

To delete one, several, or all project statements from the database, start at the 
project list screen. Use the up and down arrows to move to the project statement 
you wish to delete or press the first letter of the project statement you wish to 
delete and scroll to the exact one. Press [Alt E] for the Edit menu and [D] to 
Delete a project statement. A submenu appears from which you can choose to 

Figure 6. Funding data entry screen. 

14 RMP Software Manual 



delete one or all project statements by pressing [H] for Highlighted entry only or 
[Al for AH the project statements. If you want to delete several, but not all, 
project statements, you can either manually delete each one, or create a filter 
using the Locate menu command, and then deleting all which match that filter. 
See the section on Locate in this manual for more information. 

You can also delete one or more project statements from the project statement 
data entry screen, or from the funding screen. 

After you select a project statement to delete, a message will appear warning you 
that you are about to delete ALL data associated with the project statement or 
statements selected, including all funding data. You can enter [Y] to do the 
deletion, or [N] if you decide you don't want to do the deletion. 

How to Print Project Statements, Programming Sheets, and Tables 

You can print from the project list screen, the project statement data entry screen, 
or the funding screen. Press [Alt PJ for the Ennt menu. Then you can press [PI 
for Eroject statement, [1] for Programming sheet 1, [21 for Programming sheet 2, 
or [A] for Table 2. The other menu choices are not available at this point. Then 
press [HI to select the Highlighted or current project statement, or [Al to select 
AH project statements. Then, you can select where you want the printed output to 
go, [SI for the Screen, [Fl for a Eile of your choice, or [PI for the Erinter. It is 
recommended that you select the screen, so that you can preview your output. 
See Figure 7 to see what the submenus look like. 

Figure 7. Print menu and submenus. Each main selection is followed submenus. 
It is recommended that you print to the screen first, preview the output, and then 
select the menu command "Screen display" when satisfied. 
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If you select to output to the screen, the printed output will appear in a box on 
the screen exactly as if it were printed on a printer. You can scroll through the 
file using the arrow keys, home, end, pgup, pgdn, etc. When you are satisfied 
with the output, you can press [Alt PI for the Erint menu again, and [S] for 
Screen display, to send the output on to a printer or a file from there, or [ESC] to 
return to the previous screen without printing. 

How to View the Personnel Table List Screen 

You can switch to the personnel tables (see Figure 8) at any time by pressing 
[Alt FJ for the Eile menu and [T] for Personnel tables (or just the shortcut 
[Alt T]). If you've already entered data in a previous year, it will be converted 
automatically. If you have no data yet, a message will appear saying mat the 
personnel database is empty. 

The top right corner of the screen shows what item number that the highlight is 
on, the physical record number, and how many records you have in the database. 
The personnel tables are sorted by park, region, and fiscal year. The data in the 
columns is a sum of the funding and FTE amounts for that year. Follow the 
directions at the bottom of the screen to add and edit personnel tables. 

You can switch between personnel tables and project statements with the shortcut 
keys [Alt Tl and [Alt J], respectively. 

Figure 8. Personnel table list screen. 
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How to Add a New Personnel Table 

From any screen related to project statements, press [Alt T] to view the personnel 
tables. Press [Alt E] for the Edit menu and [Al (or just the shortcut [Alt A]) to 
Add a new personnel table (see Figure 9). Begin entering data into the fields. 
Move from field to field by pressing the arrow keys, or by pressing [ENTER]. 
Refer to the message line at the bottom of the screen for hints about what to enter 
in each field. 

As you enter data, the summed amounts will instantly reflect the new information. 
The percent calculations will not be accurate until you get to the field "Total Park 
FTEs". When you enter data into this field, the percentage line will be instantly 
updated. 

When you have finished entering data into the table, press [Alt X] to save the 
table and Exit this process (adding a new table), or [ESC] to abort the changes, 
and return to the previous screen. If you press [Esc], the new data record will 
not be added to the database. 

You can flip between personnel tables by pressing [Ctrl PgUp] and [Ctrl PgDn]. 
The current personnel table will be saved, and the previous or next one will be 
displayed, allowing you to view, edit, print, or delete it without having to exit to 
the personnel table list screen first. 

Figure 9. Personnel table data entry screen. 
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How to Append Existing Personnel from a Separate Database 

You may have some personnel tables entered with an earlier version of the RMP 
software and that are now in another directory that you would like added or 
"appended" to your "new" RMP database, or you may have some personnel tables 
on a floppy disk that you want to merge into your database. This function avoids 
appending duplicates, and automatically converts data from previous versions of 
the RMP software. 

To begin the append, Press [Alt T] to view the personnel tables. Press [Alt E] for 
the Edit menu and [P] for Append. A dialog box will appear into which you 
must type the full DOS path to the desired "source" database (see Figure 10). 
During the append, duplicate park, region, and fiscal year combinations are 
rejected and old versions of the data are converted. If this occurs, you will have 
the option of viewing and printing the duplicates after the append is completed. 
You should check the data carefully after an append to see if all of the data was 
merged successfully. 

How to Edit/Change an Existing Personnel Table 

Press [Alt T] to view the personnel tables. Move the highlight bar to the 
personnel table that you want to modify. Press [Alt El for the Edit menu and [Ml 
(or just the shortcuts [Alt Ml or [Enterl) to Modify. The personnel table data 
entry screen will appear, filled with the data for the personnel table that you 

Figure 10. The append dialog box. 
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selected (see Figure 9). When you are done, press [Alt X] to save the data and 
Exit this process (the personnel table edit) and return to the previous screen, or 
[ESC1 to abort the changes and restore the original data. 

You can flip between personnel tables by pressing [Ctrl PgUp) and [Ctrl PgDn]. 
The current personnel table will be saved, and the previous or next one will be 
displayed, allowing you to view, edit, print, or delete it without having to exit to 
the personnel table list screen first. 

How to Delete One or All Personnel Tables 

Press [Alt T] to view the personnel tables. Position the highlight bar on the 
personnel table you want to delete. Then press [Alt E] for the Edit menu and [Dl 
(or just the shortcut key [Alt Dl) to select Qelete. A submenu appears from 
which you can press [HI to select the Highlighted table, or [Al to select All tables 
in the database. After you select one of these, a message will appear asking if 
you really want to delete the data. You can press [Y] to proceed with the 
deletion, or [Nl to abort the deletion process. 

How to Print Personnel Table 2 

You can print from either the personnel table list screen or the personnel table 
data entry screen. Press [Alt PI for the Print menu and [T] for Table 1. (Project 
statement related commands are not available at this point.) A submenu appears 
from which you can press [HI to select the Highlighted or current table, or [A] to 
select AH tables. Another submenu appears from which you can select where you 
want the printed output to go, [S] for the Screen, [F] for a Eile of your choice, or 
[PI for the Printer. It is recommended that you select the screen, so that you can 
preview the output. 

If you select to output to the screen, the printed output will appear in a box on 
the screen exactly as if it were printed on a printer. You can scroll through the 
file using the arrow keys, home, end, pgup, pgdn, etc. When you are satisfied 
with the output, you can press [Alt P] for the Print menu and again and [SI for 
Screen display, to send the output on to a printer or a file from there, or [ESC] to 
return to the previous screen without printing. 

How to Quit to DOS 

From any data entry screen, you can press [Alt F] for the Eile menu and [Q] (or 
just the shortcut [Alt Ql) to save all data and Quit to DOS. If you are on the 
project list screen or personnel table list screen, you can also press [Alt X] to save 
all data and exit or press [Esc]. This will return you to the DOS prompt. 
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3. Menus and How to Use Them a 
The RMP software menu system is based on a standard method used by 
most major software today. The list of menu commands at the top of the screen 
is called the menu bar. One letter is highlighted for each menu title and 
command. The highlighted letter is called the quick key. Quick keys make it 
easy for you to pull down menus and choose commands from the keyboard, 
without having to use the arrow keys. The highlighted letters on the menu bar 
are selected by pressing and holding the [Alt] key, and then pressing the 
highlighted letter. From a pull-down menu, simply press the highlighted letter to 
choose that command. 

Choosing a command that is preceded by a • symbol causes a submenu to appear 
that lists additional commands. If you change your mind about selecting a menu 
command, press [ESC] to close the menu. For example, see Figure 11. It shows 
a series of cascading menus displayed during the print command. At any one of 
the menus, you can press [Esc] to return to a higher level menu. Repeated [Esc] 
presses will eventually remove all menus. 

When a menu command is highlighted, a message about the menu command will 
appear at the bottom of the screen on the message bar. In the opening menu bar, 
there are six options for you to use: File, Edit, Locate, Print, Setup, and Help. 
To access these menu options, press [Alt] and the first letter of each word. For 

Figure 11. Menus and submenus. 
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example, to edit a project statement press [Alt E] for the Edit menu. A submenu 
will drop down below the top line with various other menu commands such as 
Modify, Delete, Add, Append. You can highlight each command by pressing the 
arrow keys. Select a command by pressing [Enter! or by pressing the letter that 
is shown in a highlighted color within each menu command. If a menu command 
is not available at a particular point in the program, it will appear gray (on color 
screens) and will have the prefix 'N/A'. Any menu can be aborted by pressing 
[Escl. 

Some frequently used menu commands can be selected immediately without going 
through the menu system. These are called "shortcut keys". They can be found 
listed after some menu commands. For example, under the "Edit menu 
selection, there are several shortcut keys: [Alt M] for Modify, [Alt Dl for Delete, 
[Alt AJ for Add which can be pressed at any time. If you were viewing a project 
number list, you could press [Alt Ml to Modify the current highlighted entry 
rather than pressing [Alt E] for the Edit menu and then [M] to Modify. 

Partial list of "Shortcut Keys": 

[Alt A] Add a new project or personnel table 
[Alt Dl Delete the highlighted (or all if desired) project or personnel table 
[Alt J] Load and view project statements 
[Alt M] Modify (edit) the highlighted project or personnel table (or press [Enter]) 
[Alt T] Load and view personnel tables 
[Alt X] Save and exit a screen, moving back the previous screen 
[Alt Q] Save and quit to DOS 

The following pages explain what each menu command in the RMP software 
does. 
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The File Menu 

The File menu [Alt Fl allows you to perform file-related operations such as 
loading the project statements and personnel tables files, reindexing (sorting) the 
files, packing the files to their smallest size, and exiting from the RMP program. 
These are the commands available on the File menu. 

[J] Load Project Statements - shortcut [Alt J]. Loads the project 
statements database RMP.DBF for viewing, editing, and printing. Not 
available if project statements are already loaded. 

[T] Load Personnel Table — shortcut [Alt Tl: Loads the personnel table 
database RMP_PERS.DBF for viewing, editing, and printing. Not 
available if personnel tables are already loaded. 

[R] Reindex - shortcut [Alt RJ. Reindexes data so that it appears sorted. 
This takes a long time if your database is big. This will only be needed 
if you suspect that the index file are damaged. If you don't see data you 
know you have entered, or if data is showing up where it shouldn't be, 
try reindexing with this command. 

[K] PacK — shortcut [Alt Kl. When you delete data, it still takes up some 
room in the database even though its data is not accessible. The program 
uses these deleted records whenever you add a new one. However, if 
you have deleted many project statements, or one with lots of associated 
text, or you are going to back up your databases, you can shrink the 
database down to its smallest size by selecting this command. 

[XI E^it this process — shortcut [Alt X). Exits out of the current process. 
For example, if you are editing the funding amounts, it will return you to 
the project statement data entry screen. If you are in the project 
statement data entry screen, it will return you to the list of project 
numbers. If you are viewing the project list screen, it will exit the RMP 
program to the DOS prompt. 

[Ql Save and Quit to DOS - shortcut [Alt Ql. Saves the data you are 
editing or adding and returns you to the DOS prompt from any.location 
in the program. 
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The Edit Menu 

The Edit menu [Alt El is used to modify (edit or change) your data, whether it is 
your project statements or personnel tables. Changing your data includes adding 
a new project statement or personnel table, modifying an existing statement or 
table, deleting an existing statement or table, appending existing data to your 
database, and copying funding amounts from year to year within a project 
statement. 

[M] Modify - shortcuts [Alt Ml or [Enter!. Allows you to edit the 
highlighted project statement or personnel table including codes, titles, 
funding, FTEs, etc. Available only on the project list or personnel table 
list screens. 

[Dl Delete — shortcut [Alt Dl. Deletes one or all highlighted project 
statements or personnel tables. A submenu appears allowing you to 
select highlighted or all. A message appears, and you must confirm that 
you want to delete the data. Not available from the funding screen. 

[Al Add — shortcut [Alt Al. Adds a new project statement or personnel 
table to the database and places you in the edit mode. If you then press 
[ESC], the new record is not added to the database. 

[P] Append. Appends data from a previous year or in another database to 
your current database. Not available on funding screen. A dialog box 
appears into which you must specify the pathway (drive letter and path 
name where the file is located) e.g. A:, B:, D:\DBASE\RMP91, etc. 
This procedure converts previous database formats, checks for duplicates, 
and allows you to view and print any errors listed below. 

Invalid Codes - codes which were invalid during the conversion 
from previous year's data. 

Combined records - records that were combined into one record 
because duplicate project numbers existed. Some users have 
entered single projects into several separate data records in order 
to split funding amounts. If a project number and title is 
duplicated in the source file, the duplicate records will be 
combined. 

New project numbers - created by the program during the 
append because you did not want to combine into one database if 
duplicate project numbers existed. Also created when a project 
number was duplicated, but the title was different. 

[CI Copy Funding. Copies sources codes, activity codes, funding, and 
FTEs from one year to another year within a Funded or Unfunded 
column. A dialog box opens with instructions. Available only on the 
funding screen. 
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The Locate Menu 

The Locate menu [Alt L] helps you locate data in any field of any project 
statement or personnel table. It has two basic methods: it can either place the 
highlight on the project statement with the data in it, or it can create a "filter" 
which allows only those projects or tables containing the data to be seen, hiding 
all others from any operation until the filter is changed or removed. 

[S] Search for data. Searches the database for any data and moves the 
highlight to that data project or personnel table. A series of submenus 
appears allowing you to select a data field to search, to enter strings or 
numbers to search for, to edit the search condition, and to add more 
conditions to an existing condition. You have to enter values exactly the 
way they appear in the database, including upper/lower case, number of 
spaces, etc. Thereafter, you can use [Ctrl LI to search again. 

[G] Go to a record number. Goes to a particular physical record number in 
the database. A dialog box appears into which you enter the record 
number you want to go to. Record numbers can be found by looking in 
the upper right corner of the project list screen in the form NNN/NNN, 
where the first NNN is the physical record number and the second is the 
total number of records in the database. 

[K] SJdp forward or backward. Skips forward or backward a specified 
number of data records. A dialog box appears into which you type the 
number of records you want to skip. A negative number will cause the 
skip to be backward, a positive number causes a forward skip. 

A "filter" is similar to a search, except that it "hides" all projects or personnel 
tables that don't meet your specified criteria. Thereafter, all operations you do 
operate only on the projects or personnel tables that meet your filter criteria, 
including delete, modify, print, search, etc. You can create as many different 
filters as you want, store them on disk, and reactivate them with the "restore" 
command below. The filter that is in effect is called the "current filter" and is 
displayed at the bottom of the project and personnel table list screens. You can 
"undo" a filter at any time by using the "unfiltered" command below, returning 
you to the entire, unfiltered database. 

Note; If you have a filter in effect, and you add a new project which does not 
match that filter, the new project will seem to disappear. 

[M] Make a new filter. Allows you to create different filters, thus hiding 
some data. A series of submenus appear allowing you to select fields to 
set the filter on, to enter strings or numbers to use in the filter, to add to 
a current filter, and to edit the existing filter. The active filter will be 
displayed at the bottom of the screen after you exit this menu, to remind 
you that there is a filter in effect. 
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[Al Add to current filter. Allows you to add more to an existing filter. 
For example, if the filter is '"HISTORIC" $ TITLE1', this command 
allows you to add more to it, such as '"HISTORIC" $ TITLE1 .AND. 
"BICY" $ PROJ_NMBR' without having to recreate the entire filter. 

[El Edit current filter. Allows you to edit an existing filter. A dialog box 
opens with the current filter displayed, allowing you to change it. 

[CI Count filtered records. Counts the number of records (projects or 
tables) that match the current filter. 

[V] Save a filter to disk. Saves a filter to disk in a special RMP file so that 
you can invoke it again at any time. 

[R] Restore a filter from disk. Displays filters that you have saved to disk 
in a special RMP file. You can reactivate one by highlighting it and 
pressing [Enter]. 

[Ul JJnfiltered, include all. Removes any current active filter, allowing all 
data in the database to be* accessed. This will not delete any filters that 
you have saved to disk; those will still be there for you to restore if you 
wish. Remember to save a filter to disk if you want to keep it for later, 
because this command does not save it for you. 
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The Print Menu 

The Print menu [Alt PI allows you to print project statements, programming 
sheets 1 and 2, and tables 1 and 2. You can print to the screen, a file that you 
specify, or to a printer. Printing to the screen is recommended, because you can 
then preview the output and, if satisfied, print it from the preview screen to a file 
or printer. 

All commands in this menu have submenus. After you select the project 
statement command, a submenu allows you to print the highlighted project or all 
projects. Then, for all commands, another submenu appears allowing you to 
select the destination for the output: the screen, a file of your choice, or a printer. 
It is recommended that you print to the screen first, and if you are satisfied with 
the output, select [Alt PI for the Erint menu and [SI for Screen display to send the 
output on to a file or a printer. 

[PI Project statement. Prints project statements to the screen, a file, or the 
printer. Available from project list, project statement data entry, and 
funding screens only. 

[1] Programming sheet 1. Prints programming sheet 1 (funded projects) to 
the screen, a file, or the printer. Available from project list, project 
statement data entry, and funding screens only. 

[2] Programming sheet Z- Prints programming sheet 2 (unfunded projects) 
to the screen, a file, or the printer. Available from project list, project 
statement data entry, and funding screens only. 

[Tl Xable 1. Prints table 1 (personnel table) to the screen, a file, or the 
printer. Available from personnel table list and personnel data entry 
screens only. 

[A] Table 2. Prints table 2 (budget table) to the screen, a file, or the 
printer. Available from project list, project statement data entry, and 
funding screens only. 

[SI Screen display. This command is only available when you are viewing 
output on the screen in the big window. Any output that you create can 
be previewed on the screen, and then, if you are satisfied with it, can be 
sent on to a file or printer using this command. 
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The Setup Menu 

The Setup menu [Alt SI lets you set the "default" settings for the program, 
including your printer type, monitor type (color or monochrome), which park or 
region you are working with, what year you are working with, what resource type 
you most commonly use, whether you want to turn color off, whether you want to 
flip black and white colors, and whether you want to see file index progress or 
not. Default values are used for new projects or tables and can be edited and 
changed within a project statement or personnel table to whatever you want them 
to be. 

[PI Printer type. Allows you to select the type of printer that will be used 
in this program. A submenu opens from which you select your printer. 
If your printer is not listed, you can choose to manually type in the 
printer control codes for condensed and normal print. You can also use 
the command 'Turn box characters on/off' to translate all graphical 
characters such as || or ^= into characters which older printers can print 
such as | and +. 

Submenu commands: 

Epson/compatible 
HP Laserjet 
IBM/compatible 
Not on this list 
Okidata-standard 
Toshiba 
Turn box characters off 

[M] Monitor type. Allows you to select the type of monitor that is 
connected to your computer. If you cannot see the flashing cursor on 
your monitor, try using this command to select Mono. 

Submenu commands: 

Color monitor 
Mono (2 Colors) 
Laptop (Gray Tones) 

[Al Park Code. Allows you to enter the four-letter alpha park code that you 
want to be automatically inserted in new project codes. 

[RI Region Code. Allows you to select one of the ten region codes that you 
want to be automatically used when adding new personnel tables. 

(TJ Default Resource Type. Allows you to select the resource codes that 
you want to be automatically used in new project numbers. 

[Y] Default Fiscal Xear. Allows you to enter the year which you want to be 
automatically used when adding new personnel tables. 
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[CI Turn Color On/Off. Turns color on and off. Most laptops with black 
and white screens fool software into thinking that they have color. If 
you cannot see some messages, or the blinking cursor, or the highlight 
bar, set color off. 

[F] Flip black/white. This command is only available if you have a 
monochrome monitor or if you have turned color off. It causes all white 
areas to become black, and all black areas to become white. 

[II Turn Index Box On/Off. Turns the index box on or off. When the 
program has to create or update an index file, it can take many minutes. 
The index progress box displays indexing progress so that you know that 
your computer is not locked up. However, this makes the index process 
a little bit slower. If you want the fastest indexing, turn this box off. 
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4. Required and Optional Equipment 4 
The RMP software is designed to run on micro computers. With the 
huge variety of systems available, the software may not run exactly as intended on 
some configurations. Contact technical support if you experience any problems. 

Equipment Requirements 

To use RMP, you must have the following: 

• an IBM PC or compatible 

• PC-DOS or MS-DOS operating system (version 3.3 or later 
recommended) 

• at least 400Kb free RAM memory 

• a hard-disk drive with at least 1Mb free for installation and for sufficient 
room to enter data 

To find out what version of DOS you have, type ver [Enter! at the DOS prompt. 

To find out how much free RAM you have, type chkdsk [Enter] at the DOS 
prompt. Read the line that has "total bytes memory" or similar on it. 

To find out how much free hard-disk space you have, read the CHKDSK line that 
has "bytes available on disk" or similar on it. 

When you first install RMP, you need about 400Kb of disk space just for the 
program. The database files can quickly fill up with data. It is a good idea to 
have at least 1Mb of hard-disk space free at all times while using RMP. 

When you install upgrades, the upgrade will write over the original program files, 
so you won't need any extra disk space. 

RMP Software Manual 31 



Optional Equipment 

You don't need the following equipment, but each option will enhance RMP. 

Printer. You can print output with dot matrix, daisy wheel, or laser printers. 
You can also print either to the screen or to a file. Some output is over 80 
characters wide, but both dot matrix and laser printers can output in condensed 
print, so even if you have a narrow cartridge printer, you will be able to get all 
your output. However, daisy wheel printers may not produce good output. 

RAM Disk. A RAM disk is actually a region of computer memory that behaves 
exactly as if it were a disk drive. RAM disks are much faster than hard disks 
because they have no moving parts and the information they contain is always 
loaded into memory. The tradeoff is that RAM disks are volatile; all data stored 
on them vanishes when you turn the power off or when the current to your 
computer is lost. 

You create a RAM disk by using a program such as Microsoft's 
RAMDRIVE.SYS or VDISK.SYS which come free with many MS-DOS versions. 
These commands are placed in your CONFIG.SYS file. (Refer to your DOS 
manual.) The only reason to used a RAM disk with RMP is if you have at least 
300Kb of extended or expanded memory above the 640Kb of conventional DOS 
memory; installing a RAM disk in conventional DOS memory below 640Kb will 
probably cause RMP to fail to run because it will take up memory that RMP 
needs to run. The usual command to include in your CONFIG.SYS file for 
RAMDRIVE.SYS is: 

device • c:\dos\ramdrive.sys [size] [sector size] [entries] [/e or /a] 

where size is the disk size in kilobytes, sector size is the disk sector size which 
should be 128, 256 (best for RMP), 512, or 1024, and entries is the number of 
root directory entries. The /e specifies to use extended memory. The /a specifies 
use expanded memory. 

An example of a RAMDRIVE that is 1024kb is size, 256 byte sector size with 
room for 56 directory entries, in expanded memory would be: 

device = c:\dos\ramdrive.sys 1024 256 56 /a 

Because RAM disks can lose their data, it is recommended that you use a RAM 
disk ONLY as specified here. Copy RMP.EXE and RMP.OVL to the RAM disk 
with the command copy rmp.exe g: [Enter] and copy rmp.ovl g: [Enter] where g: 
is the disk drive letter of the RAM disk. Then run the RMP program by 
specifying the disk drive letter of the RAM disk, as in g:\rmp [Enter]. This 
causes the program to always look to the RAM disk for information it needs from 
RMP.OVL while the program is running, instead of from the hard-disk. This 
will cause a noticeable speed increase in RMP operations, but no data will be at 
risk on the RAM disk. 
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Another benefit of a RAM disk is that many RMP operations create temporary 
files, and these can be created on the RAM disk instead of the slower hard disk. 
For this to work, you need to set an environment variable called TMP or TEMP 
by using the command set tmp»g:\ [Enter] or set temp = g:\ [Enter] where g: is 
the drive letter of the RAM drive. This tells DOS to use the RAM drive for 
many temporary file operations. You can include this command in your 
C:\ATJTOEXEC.BAT file so that it is available to other programs as well (many 
different programs use the TMP or TEMP variables), and so that it will always be 
set whenever you turn on your computer. 

To tell whether TMP is already set, just use the command set [Enter]. This will 
display a list of all variables currently in the DOS environment. 

A sample batch file to run RMP from a RAM disk might be: 

c: 
cd \rmp 
if not exist g:\rmp.exe copy rmp.exe g: 
if not exist g:\rmp.ovi copy rmp.ovl g: 
set tmp = g:\ 
g:\rmp 

Color Monitor. RMP will run on a monochrome machine, but a color monitor is 
recommended. This is because messages, prompts, and highlights are much 
easier to see and notice, and the program is just more pleasing, fun, and easy to 
use. 

Disk Cache. A disk cache is actually a region of computer memory that stores 
data most recently read from the hard-disk. A disk cache greatly reduces the 
number of times a hard-disk must be read, and will appear to increase the speed 
of the computer itself. Every time new data must be read from the disk, such as 
when you move from one data entry record to another, the computer will check 
the cache first to see if the data is already there. If it is, the data is retrieved 
quickly, otherwise it must be read from the hard-disk, which takes longer. 

You create a disk cache by using a program such as Microsoft's 
SMARTDRV.SYS (free with some versions of DOS or WINDOWS) or Norton's 
NCACHE-F or PCTools PC-CACHE. (Refer to the manuals that come with the 
disk cache.) The only reason to used a disk cache with RMP is if you have 
extended or expanded memory above the 640Kb of conventional DOS memory; 
installing a disk cache in conventional DOS memory below 640Kb will probably 
cause RMP to fail to run because it will take up memory that RMP needs to run. 
The command needed in the C:\CONFIG.SYS file for SMARTDRV.SYS would 
be: 

device = \dos\smartdrv.sys [size] [/a or /e] 
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The size is the amount of memory you want to use for the cache, the /a is used to 
place the cache in expanded memory, the It is to place it in extended memory. 
For example, to set up a smart disk drive cache in 1024Kb of expanded memory, 
you could have the following command in your C:\CONFIG.SYS file: 

device • C:\dbs\smartdrv.sys 1024 /a 

Math Co-processor. A math co-processor will speed up some operations. 
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Appendix A 
Project Statement Sheet 

KIMO-N-004.000 

PROJECT STATEMENT SHEET 

PROJECT NUMBER: KIMO-N-004.000 

TITLE: DEVELOP MINERALS MANAGEMENT PROGRAM 

FUNDING STATUS: FUNDED: 20.0 UNFUNDED: 95.0 

SERVICEWIDE ISSUES: N10 MINRL/GEOTHERM 

CULTURAL RESOURCE TYPE CODE: OBJ 

10-23 8 PACKAGE NUMBER: 

PROBLEM STATEMENT: 

Strip/Stone Quarry mining activity is heavy in areas adjacent to 
the park. Sub-surface mining and quarry operations were present 
within the park prior to its establishment as a National Military 

Park in 1931. There are two known abandoned mining sites ( one 
slate quarry and one sub-surface Manganese) within the park. The 

effects of adjacent raining activities on the Kings Creek water 
quality is unknown. 

DESCRIPTION OF RECOMMENDED PROJECT OR ACTIVITY: 

Inventory the two known abandoned mining sites and transmit data 
to Mining and Minerals Division of NPS for development of mine 
reclamation plans. Develop and implement water quality 
monitoring program to determine the effects of adjacent mining 
activities on the water quality of Kings Creek. 
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BUDGET AND FTEs: 
FUNDED-

Source Act Type Budget ($1000s) FTEs 

Year 1: WATER RES RES 15.0 0.5 

ENER-MIN RES 5.0 0.5 

Year 2: 

Year 3: 

Year 4: 

Total: 20.0 1.0 
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UNFUNDED 

Source Act Type ' Budget ($1000s) FTEs 

Year 1: WATER RES RES 45.0 1.0 

ENER-MIN RES 5.0 0.2 

Year 2: PARK-NR MON 15.0 0.5 

Year 3: PARK-NR MON 15.0 0.5 

Year 4: PARK-NR MON 15.0 0.5 

Total: 95.0 2.7 

(OPTIONAL) ALTERNATIVE ACTIONS/SOLUTIONS AND IMPACTS: 

NONE. 

COMPLIANCE CODE(s): EXCL 

EXPLANATION: 516 DM6 APP. 7.4 B(9) & (10) 

Proposal Date: 91 



Appendix B 
Servicewide Issue Codes 

NATURAL 
SERVICEWIDE ISSUES CODES 

NAT ANML OVPOP N01 

T&E ANIMAL N02 

T&E PLANTS N03 

NON-NAT ANIMAL NO4 

NON-NAT PLANTS NO5 

LAND USE PRAC NO6 

NAT FIRE REGM NO7 

CULT LANDSCAPE NO8 

COASTAL DYNAM NO9 

MINRL/GEOTHERM N10 

WATER QUALL-EXT Nil 

WATER FLOW N12 

WATER RIGHTS N13 

AIR POLLUTION N14 

AIRCRFT OVRFLT N15 

NEAR-PARK DEV N16 

BIODIVERSITY N17 

VIS USE-BCTRY N18 

CONSUMPT USE N19 

BASELINE DATA N20 

CAVE RESOURCES N21 

VIS USE-DEV ZN N2 2 

PALEONTOLOGY N2 3 

OTHER N2 4 

CULTURAL 
SERVICEWIDE ISSUES CODES 

INADEQUATE DOC C01 

INADEQUATE INV CO2 

MUS CATALOGING CO3 

ETHNOGRAPHY CO4 

NEED HSRS C05 

NEED HSPGS CO6 

INADEQUATE LCS C07 

NEED ADMN HIST C08 

NEED COLL MGMT C09 

SPECIAL STUDY CIO 

CULT LAND REPT Cll 

PRESERV MGMT CI2 

REHAB/RESTORAT CI 3 

ARCH DATA RECV C14 

CONSERV TREAT C15 

MUS STORAGE CI6 

CTRL ENV IMPAC C17 

CTRL VIS IMPAC CI8 

INADEQ MONITOR C19 

INADEQ SECURIT C20 

EMER STABILIZ C21 

OUT THREATS CR C22 

CONFLICT ACTVS C2 3 

INSUFF STAFF C24 

NEED CRM TRAIN C2 5 

OTHER C2 6 

RMP Software Manual - Appendix B 37 

B 



Appendix C 
Cultural Resource Type Codes C 

RESOURCE TYPE CODE 

Archeological Site SITE 

Structure STRC 

Object OBJC 

Cultural Landscape CULL 

Ethnographic Resource ETHN 

Combination COMB 
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Appendix D 
Compliance Codes D 

COPS DESCRIPTION OF ACTIVITY 

EXCL Categorical Exclusion (cite the exclusion 
reference) 

EA Environmental Assessment 

EIS Environmental Impact Statement 

DOC Covered by compliance from another document (cite 
the document title and date) 

ESA Section 7 consultation under the Endangered 
Species Act 

NHPA Section 106 compliance of the National Historic 
Preservation Act 

HSPG Addressed in a Historic Structure Preservation 
Guide 

ARPA Compliance with'the Archeological Resources 
Protection Act 

OTHER Other compliance (cite the type and authority of 
the compliance) 
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Appendix E 
Categorical Exclusions E 
S16 DM2 App. 2, 1.1 Personnel actions and investigations 

and personnel services contracts. 

516 DM2 App. 2, 1.2 Internal organizational changes and facility 
and office reductions and closings. 

516 DM2 App. 2, 1.3 Routine financial transactions, including such 
things as salaries and expenses, procurement 
contracts, guarantees, financial assistance, 
income transfers, audits, fees bonds and 
royalties. 

516 DM2 App. 2, 1.4 Law enforcement and legal transactions, 
including such things as arrests, 
investigations, patents, claims, legal 
opinions, and judicial activities including 
their initiation, processing, settlement, 
appeal or compliance. 

516 DM2 App. 2, 1.5 Regulatory and enforcement actions, including 
inspections, assessments, administrative 
hearings and decisions; when the regulations 
themselves or the instruments of regulations 
(leases, permits, licenses, etc.) have 
previously been covered by the NEPA process or 
are exempt from it. 

516 DM2 App. 2, 1.6 Non-destructive data collection, inventory 
(including field, aerial and satellite 
surveying and mapping), study, research and 
monitoring activities. 

516 DM2 App. 2, 1.7 Routine and continuing government business, 
including such things as supervision, 
administration, operations, maintenance and 
replacement activities having limited context 
and intensity; e.g. limited size and magnitude 
or short-term effects. 

516 DM2 App. 2, 1.8 Management formulation, allocation, transfer 
and reprogramming of the Department's budget at 
all levels. (This does not exclude the 
preparation of environmental documents for 
proposals included in the budget when otherwise 
required.) 
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516 DM2 App. 2, 1.9 Legislative proposals of an administrative or 
technical nature, including such things as 
changes in authorizations for appropriations, 
and minor boundary changes and land 
transactions; or having primarily economic, 
social, individual or institutional effects; 
and comments and reports on referrals of 
legislative proposals. 

516 DM2 App. 2, 1.10 Policies, directives, regulations and 
guidelines of an administrative, financial, 
legal, technical or procedural nature; or the 
environmental effects of which are too broad, 
speculative or conjectural to lend themselves 
to meaningful analysis and will be subject 
later to the NEPA process, either collectively 
or case-by-case. 

516 DM2 App. 2, 1.11 Activities which are educational, 
informational, advisory or consultative to 
other agencies, public and private entities, 
visitors, individuals or the general public. 

516 DM2 App. 2, 2.1 Have significant adverse effects on public 
health or safety. 

516 DM2 App. 2, 2.2 Have adverse effects on such unique geographic 
characteristics as historic or cultural 
resources, park, recreation or refuge lands, 
wilderness areas, wild or scenic rivers, sole 
or principal drinking water aquifers, prime 
farmlands, wetlands, floodplains, or 
ecologically significant or critical areas, 
including those listed on the Department's 
National Register of Natural Landmarks. 

516 DM2 App. 2, 2.3 Have highly controversial environmental 
effects. 

516 DM2 App. 2, 2.4 Have highly uncertain and potentially 
significant environmental effects or involve 
unique or unknown environmental risks. 

516 DM2 App. 2, 2.5 Establish a precedent for future action or 
represent a decision in principle about future 
actions with potentially significant 
environmental effects. 

516 DM2 App. 2, 2.6 Be directly related to other actions with 
individually insignificant but cumulatively 
significant environmental effects. 
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516 DM2 App. 2, 2,7 

516 DM2 App. 2, 2.8 

516 DM2 App. 2, 2.9 

516 DM2 App. 2, 2.10 

Have adverse effects on properties listed or 
eligible for listing on the National Register 
of Historic Places. 

Have adverse effects on species listed or 
proposed to be listed on the List of Endangered 
or Threatened Species, or have adverse effects 
on designated Critical Habitat for these 
species. 

Require compliance with executive Order 11988 
(Floodplain Management), Executive Order 11990 
(Protection of Wetlands), or the Fish and 
Wildlife Coordination Act. 

Threaten to violate a Federal, State, local or 
tribal law or requirement imposed for the 
protection of the environment. 

516 DM6 App. 7.4 

516 DM6 App. 7.4 A(l) 

516 DM6 App. 7.4 A(2) 

516 DM6 App. 7.4 A(3) 

516 DM6 App. 7.4 A(4) 

516 DM6 App. 7.4 A(5) 

516 DM6 App. 7.4 A(6) 

516 DM6 App. 7.4 A(7) 

In addition to the actions listed in the 
Departmental categorical exclusions in Appendix 
1 of 516 DM 2, many of which the Service also 
performs, the following NPS actions are 
designated categorical exclusions unless the 
action qualifies as an exception under Appendix 
2 to 516 DM 2; 

Changes or amendments to an approved action 
when such changes would cause no or only 
minimal environmental impact. 

Land and boundary changes 

Minor boundary changes 

Reissuance/renewal of permits, rights-of-way or 
easements not involving new environmental 
impacts. 

Conversion of existing permits to rights-of-
way when such conversions do not continue or 
initiate unsatisfactory environmental 
conditions. 

Issuance extensions, renewals, reissuance or 
minor modifications of concession contracts or 
permits not entailing new construction. 

Commercial use licenses involving no 
construction. 
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516 DM6 App. 7.4 A(8) Leasing of historic properties in accordance 

with 36 CFR Part 18 and NPS-38. 

516 DM6 App. 7.4 A(9.) Preparation and issuance of publications. 

516 DM6 App. 7.4 A(10) Modifications or revisions to existing 

regulations, or the promulgation of new 
regulations for NPS-administered areas, 
provided the modifications, revisions or new 
regulations do not: 
(a) Increase public use to the extent of 
compromising the nature and character of the 
area or causing physical damage to it; 

(b) Introduce noncompatible uses which might 
compromise the nature and characteristics of 
the area, or cause physical damage to it; 

(c) Conflict with adjacent ownerships or land 
uses; or 

(d) Cause a nuisance to adjacent owners or 
occupants. 

516 DM6 App. 7.4 A(ll) At the direction of the NPS responsible 
official, actions where NPS has concurrence or 
coapproval with another bureau and the action 
is a categorical exclusion for that bureau. 

516 DM6 App. 7.4 8 Plans, Studies and Reports 

516 DM6 App. 7.4 B(l) Changes or amendments to an approved plan, when 
such changes would cause no or only minimal 
environmental impact. 

516 DM6 App. 7.4 B(2) Cultural resources maintenance guides, 
collection management plans and historic 
furnishings reports. 

516 DM6 App. 7.4 B(3) Interpretive plans (interpretive prospectuses, 
audio-visual plans, museum exhibit plans, 
wayside exhibit plans). 

516 DM6 App. 7.4 B(4) Plans, including priorities, justifications and 
strategies, for non-manipulative research, 
monitoring, inventorying and information 
gathering. 
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516 DM6 App. 7.4 B(5) Statements for management, outlines of planning 
requirements and task directives for plans and 
studies. 

516 DM6 App. 7.4 B(6) Technical assistance to other Federal, State 

and local agencies or the general public. 

516 DM6 App. 7.4 B(7) Routine reports required by law or regulation. 

516 DM6 App. 7.4 B(8) Authorization, funding or approval for the 
preparation of Statewide Comprehensive Outdoor 
Recreation Plans. 

516 DM6 App. 7.4 B(9) Adoption or approval of surveys, studies, 
reports, plans and similar documents which will 
result in recommendations or proposed actions 
which would cause no or only minimal 
environmental impact. 

516 DM6 App. 7.4 B(10) Preparation of internal reports, plans, studies 
and other documents containing recommendations 
for action which NPS develops preliminary to 
the process of preparing a specific Service 
proposal or set of alternatives for decision. 

516 DM6 App. 7.4 B(ll) Land protection plans which propose no 
significant change to existing land or visitor 
use. 

516 DM6 App. 7.4 B(12) Documents which interpret existing mineral 
management regulations and policies, and do not 
recommend action. 

516 DM6 App. 7.4 C Actions Related to Development 

516 DM6 App. 7.4 C(l) Land acquisition within established park 
boundaries. 

516 DM6 App. 7.4 C(2) Land exchanges which will not lead to 
significant changes in the use of land. 

516 DM6 App. 7.4 C(3) Routine maintenance and repairs to non-historic 
structures, facilities, utilities, grounds and 
trails. 

516 DM6 App. 7.4 C(4) Routine maintenance and repairs to cultural 
resource sites, structures, utilities and 
grounds under an approved Historic Structures 
Preservation Cuide or Cyclic Maintenance Guide; 
or if the action would not adversely affect the 
cultural resource. 
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516 DM6 App. 7.4 C(5) Installation of signs, displays, kiosks, etc. 

516 DM6 App. 7.4 C(6) Installation on navigation aids. 

516 DM6 App. 7.4 C(7) Establishment of mass transit systems not 
involving construction, experimental testing of 
mass transit systems, and changes in operation 
of existing systems (e.g., routes and schedule 
changes). 

516 DM6 App. 7.4 C(8) Replacement in kind of minor structures and 
facilities with little or no change in 
location, capacity or appearance. 

516 DM6 App. 7.4 C(9) Repair, resurfacing, striping, installation of 
traffic control devices, repair/replacement of 
guardrails, etc., on existing roads. 

516 DM6 App. 7.4 C(10) Sanitary facilities operation. 

516 DM6 App. 7.4 C(ll) Installation of wells, comfort stations and pit 
toilets in areas of existing use and 
undeveloped areas. 

516 DM6 App. 7.4 C(12) Minor trail relocation, development of 
compatible trail networks on logging roads or 
other established routes, and trail maintenance 
and repair. 

516 DM6 App. 7.4 C(13) Upgrading or adding new overhead utility 
facilities to existing poles, or replacement 
poles which do not change existing pole line 
configurations. 

516 DM6 App. 7.4 C(14) Issuance of rights-of-way for overhead utility 
lines to an individual building or well from an 
existing line where installation will not 
result in significant visual intrusion and will 
involve no clearance of vegetation other than 
for placement of poles. 

516 DM6 App. 7.4 C(15) Issuance of rights-of-way for minor overhead 
utility lines not involving placement of poles 
or tower and not involving vegetation 
management of significant visual intrusion in 
an NPS-administered area. 

516 DM6 App. 7.4 C(16) Installation of underground utilities in 
previously disturbed areas having stable soils, 
or in an existing utility right-of-way. 
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516 DM6 App. 7.4 C(17) Construction of minor structures, including 
small improved parking lots, in previously 
disturbed or developed areas. 

516 DM6 App. 7.4 C(1S) Construction or rehabilitation in previously 
disturbed or developed areas, required to meet 
health or safety regulations, or to meet 
requirements for making facilities accessible 
to the handicapped. 

516 DM6 App. 7.4 C(19) Landscaping and landscape maintenance in 
previously disturbed or developed areas. 

516 DM6 App. 7.4 C(20) Construction of fencing enclosures or boundary 
fencing posing no effect on wildlife 
migrations. 

516 DM6 App. 7.4 D Actions Related to Visitor Use 

516 DM6 App. 7.4 D(l) Carrying capacity analyses. 

516 DM6 App. 7.4 D(2) Minor changes in amounts or types of visitor 
use for the purpose of ensuring visitor safety 
or resource protection in accordance with 
existing regulations. 

516 DM6 App. 7.4 D(3) Changes in interpretive and environmental 
education programs. 

516 DM6 App. 7.4 D(4) Minor changes in programs and regulations 
pertaining to visitor activities. 

516 DM6 App. 7.4 D(5) Issuance of permits for demonstrations, 
gatherings ceremonies, concerts, arts and 
crafts shows, etc., entailing only short-term 
or readily mitigable environmental disturbance. 

516 DM6 App. 7.4 D(6) Designation of trailside camping zones with no 
or minimal improvements. 

516 DM6 App. 7.4 E Actions Related to Resource Management and 
protection 

516 DM6 App. 7.4 E(l) Archeological surveys and permits, involving 
only surface collection or small-scale test 
excavations. 

516 DM6 App. 7.4 E(2) Day-to-day resource management and research 
activities. 

516 DM6 App. 7.4 E(3) Designation of environmental study areas and 
research natural areas. 
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516 DM6 App. 7.4 E(4) 

516 DM6 App. 7.4 E(5) 

516 DM6 App. 7.4 E(6) 

516 DM6 App. 7.4 E(7) 

516 DM6 App. 7.4 E(8) 

Stabilization by planting native plant species 
in disturbed areas. 

Issuance of individual hunting and/or fishing 
licenses in accordance with State and Federal 
regulations. 

Restoration of noncontroversial native species 
into suitable habitats within there historic 
range, and elimination of exotic species. 

Removal of park resident individuals of non-
threatened/endangered species which pose a 
danger to visitors, threaten park resources or 
become a nuisance in areas surrounding a park, 
when such removal is included in an approved 
resource management plan. 

Removal of non-historic materials and 
structures in order to restore natural 
conditions. 

516 DM6 App. 7.4 E(9) 

516 DM6 App. 7.4 F 

516 DM6 App. 7.4 F(l) 

516 DM6 App. 7.4 F(2) 

516 DM6 App. 7.4 F(3) 

516 DM6 App. 7.4 F(4) 

Development of standards for, and 
identification, nomination, certification and 
determination of eligibility of properties for 
listing in the National Register of Historic 
Places and the National Historic Landmark and 
National Natural Landmark Programs. 

Actions Related to Grant Programs 

Proposed actions essentially the same as those 
listed in paragraphs A-E above. 

Grants for acquisition of areas which will 
continue in the same or lower density use with 
no additional disturbance to the natural 
setting. 

Grants for replacement or renovation of 
facilities at their same location without 
altering the kind and amount of recreational, 
historical or cultural resources of the area; 
or the integrity of the existing setting. 

Grants for construction of facilities on lands 
acquired under a previous NPS or other Federal 
grant provided that the development is in 
accord with plans submitted with the 
acquisition grant. 
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516 DM6 App. 7.4 F(5) Grants for tha construction of new facilities 
within an existing park or recreation area, 
provided that the facilities will not: 

(a) Conflict with adjacant ownerships or land 
use, or causa a nuisance to adjacant ownership! 
or occupants; e.g., extend use beyond daylight 
hours; 

(b) Introduce motorized recreation vehicles; 

(c) Introduce active recreation pursuits into 
a passive recreation area; 

(d) Increase public use or introduce 
noncompatible uses to the extent of 
compromising tha nature and character of the 
property or causing physical damage to it; or 

(e) Add or altar access to the park from the 
surrounding area. 

516 DM6 App. 7.4 F(6) Grants for the restoration, rehabilitation, 
stabilization, preservation and reconstruction 
(or the authorization thereof) of properties 
listed on or eligible for listing on the 
National Register of Historic Places, at their 
same location and provided that such actions: 

(a) Will not alter the integrity of the 
property or its setting; 

(b) will not increase public use of the area 
to the extent of compromising the nature and 
character of the property. 

(c) Will not cause a nuisance to adjacent 
property owners or occupants. 

RMP Software Manual - Appendix E SI 



Appendix F 
Funding Source Codes 

Finding Source Cod* 

PARK 

Recurring (Permanent) Operating Base-Nat. Resources PNR1 PKBASE-NR 
Recurring (Permanent) Operating Base-Cult. Resources PCR1 PKBASE-CR 
Recurring (Permanent) Operating Base-Other POF1 PKBASE-OT 
Non-recurring (Temporary) Operating Funds-Nat. Resources PNR2 TEMPS-NR 
Non-recurring (Temporary) Operating Funds-Cult. Resources PCR2 TEHPS-CR 
Non-recurring (Temporary) Operating Funds-Other P0F2 TEMP$-OTH 
Fee Revenues PFEE FEE-REV 
Special Accounts (Historic Leasing, Agriculture) PSA SPECIAL-* 

REGION 

Natural Science Research RNSR RG-NS-RES 
Natural Resource Management RNRM RG-RM-NAT 
Cultural Resource Cyclic Maintenance RCCM RG-CR-MTN 
Regular Cyclic Maintenance RMCM RG-REG-MT 
Repair-Rehabilitation RMRR REP-REHAB 
Volunteer-In-Parks (VIP) RVIP VOL-IN-PK 
Other ROTH REG-OTHER 

SERVICEUIDC 

Natural Resource Preservation Program (NRPP) SNRP NRPP 
Water Resources SNWR WATER-RES 
Air Quality SNAQ AIR-QUAL 
Acid Precipitation SNAP ACID-PREC 
Natural Resources Inventory and Monitoring SNIM NR-IIM 
Global Climate Change SNGC CLI-CHGE 
Geographic Information System SNGS GIS 
Energy, Mining and Minerals SNEM ENER-MIN 
Fire Accounts SFIR FIRE-* 
Forest Insect and Disease Control SIOC FR-INSECT 
Cultural Resource Preservation Program (CRPP) SCRP CRPP 
Construction (Development) Program SDEV CONSTRUCT 
Emergency and Unscheduled Project (Lump Sum Construction) SOLS LUMPS-CON 
Other SOTH SVC-OTHER 

HON-HP* 

Other Federal NFEO FED-OTHER 
Stat* or Local Government Agency NSTA ST-LOCAL 
University or College NUNV UNIV-COLL 
Non-Prof it Institution (Cooperating Associations, etc.) NPRF NON-PROFI 
Financial Donations NOON (-DONATE 
Volunteer Labor and Indapafsdent Studies NvOL VOL-INDEP 
Other NOTH NON-NPS-0 

m 
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Appendix G 
Activity Codes 

^ 

ADM Administration 

INT Interpretation 

MIT Mitigation 

MON Monitoring 

PRO Protection 

RES Research 
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